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1 Program Introduction 

1.1 Overview 

SMART IDesigner provides the best solution to make a membership card and an identification 

card. SMART IDesigner allows you to design and issue a desired card conveniently. It is designed 

to be easy to use with simple essential features, but also to allow advanced users to utilize 

various detailed features. 

SMART IDesigner allows you to design cards or easily issue and manage large numbers of cards 

using the internal database. SMART IDesigner saves card design files in directories by project. The 

project directory contains the configuration file CSP, the design file CSD, and the database file 

SQLite DB and files temporarily used within the program are saved in the Backup, CaptureFiles, 

and ImageTmp folders. 

SMART IDesigner has the following features. 

 Card designs for printing on CR-80 card are easily designed with images, texts 

and barcodes (1D, 2D). 

 Easy card design 

 Desired panel objects (Color, Resin Black, Overlay and UV) can be set to be printed. 

 For portrait photos, it can recognize human faces in the portrait photo and automatically 

adjust the size and position of the photo so that only the human face is displayed in a 

defined box. 

 Use plugins to take input from many types of input devices, such as cameras, sign pads, etc. 

 Encode magnetic cards, contact smart cards, contactless smart cards, etc. using plugins. 

 Issue large numbers of cards continuously using a database. 

 Import external data or export internal data. 

 

SMART IDesigner is the program which is provided with SMART ID Card Printer. This can be 

used only with SMART ID Card Printer supplied by IDP Corp., Ltd. 

For stable operation, Windows 7, 8, 10 and 11 Pentium 1GHz with 1GB of RAM or higher are 

recommended. 

This program is not for sale. It is only for the customers of SMART ID Card Printer. No part of this 

program may be reproduced and reused by any way without the permission or the prior written 

agreement of IDP Corp. Ltd. We have no liability for any problem through the dissemination. IDP 

Corp. Ltd. All rights reserved. 
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2 Printer 

2.1 Printer Setup 

SMART IDesigner is only for the customers of SMART ID Card Printer. 

Depending on the type of SMART ID Card printer currently set, some buttons in the program 

may be activated or deactivated. Therefore, to use some functions, you need to change the 

options in the print settings. 

 

<FIGURE> 1 - PRINTER SETUP  

Menu location: File-Print Setup 

 

2.1.1 Orientation 

 

<FIGURE> 2 – ORIENTATION SETTING 

The default card design is landscape. It can be changed to a portrait design card in the 

“Orientation” section of the Print Setup window. 
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2.1.2 Side 

Depending on the printer model, double-sided printing is possible. To set single-

sided/double-sided, click “Properties” in the Print Setup window to open the Printer 

Document Properties window. 

 

<FIGURE> 3 – PRINTER DOCUMENT PROPERTIES  

In the “Printing tab” of the printer document properties window, change the Print Side 

section to “Both(Top + Bottom)” and click OK to change to double-sided printing mode. 

  

<FIGURE> 4 – PAGE BUTTON ACTIVE/INACTIVE 

  

You can check the current page settings status in the Page menu at the top of the 

Home Tab. The second "Page Set" case is enabled when using a SMART-70 multi-printer 

combination. 
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2.2 Print 

SMART IDesigner has 2 ways to print: using the print button on the "Home tab" (Driver Print) and 

printing from the "Database tab" (DLL Print). 

2.2.1 Driver Print 

 

<FIGURE> 5 – PRINT BUTTON ON HOME TAB 

When you click the Print button on the “Home tab” or “File tab,” printing will be done 

via the installed printer driver. You can directly print cards designed in SMART IDesigner. 

 

2.2.2 DLL Print 

 

<FIGURE> 6 - PRINT BUTTON ON DATABASE TAB 

On the “Database tab”, the internal DLL is used for printing. When designing cards, 

applying database fields allows you to easily print large quantities of cards by linking 

information entered into the database. 
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3 How to Use the Program 

3.1 Create Project 

SMART IDesigner provides a template wizard that allows you to create projects using pre-

designed templates. You can conveniently start designing by selecting the design type you want 

in order through the template wizard. 

 

<FIGURE> 7 – START SMART IDESIGNER 

The template wizard is progressed as the below steps. 

 

3.1.1 Create Template Project 

1) Type Setting 

Select the orientation (Landscape/Portrait) of a card and surface (Single-sided/Dual-sided) 

to print. Then click ‘Next’ button. 

c  

<FIGURE> 8 - TEMPLATE WIZARD : TYPE SETTING 
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2) Encoding Setting 

Select an encoding way into a card. SMART IDesigner can encode magnetic stripe, contact smart 

card, contactless smart card. For encoding, the selected encoder has to be installed in the printer 

and use the card that encoding is available. 

 

<FIGURE> 9 - TEMPLATE WIZARD : ENCODING SETTING 

3) Design 

Select one of the predesigned image and project or ‘Blank’ card if the user wants his own 

design. 

 

<FIGURE> 10 - TEMPLATE WIZARD : DESIGN SETTING 
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4) Finish 

Input a Project name and select the location to save it, then click “Confirm” button. 

 

<FIGURE> 11 - TEMPLATE WIZARD : FINISH SS 

 

3.1.2 Create New Project 

 

<FIGURE> 12 - CREATE NEW PROJECT 

You can create a new project by clicking the “New” button on the “File tab” or the 

“Home tab.” 

“Name” is the name of project to be designed. After creating folder as “name”, essential 

files are created. There are several files in project folder as follow. 
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<FIGURE> 13 - INSIDE PROJECT FOLDER 

 ProjectName.csp : File which contains project configuration and linked data 

information 

 ProjectName.csd : File including design data 

 ProjectName.db : File including database data 

 Backup Folder : Folder saving files for recovery when not saving under work 

 ImageTmp Folder : Folder saving image temporarily under work(Deleted when 

the project ends) 

 

“Location” is a directory to place a project. The project is set a desired location.    

“Import CSD” allows you to use an existed file designed by SMART IDesigner. To use 

“Import CSD” function, checkbox for “Import CSD File” is marked and CSD file in your 

folder is set. When using “Import CSD”, original CSD file is copied in new project and 

then used. 

If you do not do "Load CSD" the initial state will be set to a blank design. 

 

3.2 Design 

3.2.1 Object 

 

<FIGURE> 14 – DRAWING MENU ON HOME TAB  

Use drawing objects to design the cards. Text/barcode/image objects can be linked to 

each database field. Each object can be aligned, rotated, mirrored, and fixed, and images 

can be edited separately. 
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<FIGURE> 15 – CARD DESIGN  

You can use drawing objects to design a card as shown in Figure 15.  

You can use the “Edit Background Image” to set an image as the background and place 

various shape objects, images, text, barcodes, etc. The dotted box represents an object 

that has established a connection to the database. See Section 3.3.1. 

 

<FIGURE> 16 – OBJECT PROPERTY WINDOW  

Double-clicking each object or right-clicking > selecting Object Properties will open the 

Object Properties window. You can use various settings, such as fixing the object or 

modifying data. 
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3.2.2 Panel 

 

<FIGURE> 17 – COLOR PANEL OBJECT & BLACK PANEL OBJECT  

 

  

<FIGURE> 18 – OVERLAY PANEL OBJECT & FLUORESCENT PANEL OBJECT  

In "Panel" you can set which panel you want to use for each object when printing. 

If your printer uses a ribbon with YMC panels, the Color panel is enabled and images 

and shapes default to color objects. Text and barcodes default to black and white panels. 

If you use a Mono Ribbon or KO Ribbon on your printer, all objects will be set as black 

and white panels. 

A ribbon with O or F panels, you can set objects to Overlay and Fluorescent panels. 

 

3.2.3 Background 

 

<FIGURE> 19 – OPTION MENU ON OPTION TAB  

The background can be set as a solid color or an image. 
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<FIGURE> 20 – BACKGROUND SETTING WINDOW  

You can choose a background color by clicking “Set background color”. You can set an 

image as the background by clicking “Edit background image”. 

 

3.3 Card Data 

3.3.1 Create CSD Field 

Select the object to be linked to the database as shown in Figure 21, right-click, select 

"Add New Field" from "Input Field" in the pop-up menu to create a new field, or select 

an already created field according to the properties of each object to link it to the 

database. 

 

<FIGURE> 21 – CREATE CARD DATA FIELD  
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3.3.2 Input 

In the "Database" tab, you can enter data in the input fields defined as shown in Figure 

22 and print. 

 

 

<FIGURE> 22 – CARD DATABASE & RIBBON MENU  

Click the “Add” button on the Database tab, a window will appear where you can enter 

data as shown in Figure 23. 

After entering the data, you can click “Add Continue” button to continuously add new 

card and data. 

 

<FIGURE> 23 – INPUT CARD DATA  
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3.3.3 Preview 

 

<FIGURE> 24 - PREVIEW  

Card data details and card image preview of the selected card can be checked on the 

right side of the 'Database tab'. 

 

3.3.4 Edit Image 

 

<FIGURE> 25 – EDIT IMAGE WINDOW  

If you want to edit an image in the "Database" tab, double-click the image in the Preview section 

and the "Edit Image" window will open. 

In the "Edit Image" window, you can set the size, brightness/contrast/rotation of the image, etc., 

and you can conveniently edit the image with the Auto Portrait and Auto Effect functions. 
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3.3.5 Card Issuing 

Select the card to be issued as shown in Figure 26 (the selected card will be light blue), 

click the “Print” button, and then select the printer to print to. 

 

<FIGURE> 26 – PRINTER SELECTION WINDOW  

After selecting a printer and clicking the “Confirm” button, you can check the list of card 

data to be printed in the printer spool window, and when you click the “Print” button, 

the selected cards will be issued continuously. 

 

<FIGURE> 27 – DATA VERIFICATION WINDOW BEFORE CARD ISSUANCE  

SMART IDesigner can print to multiple connected printers. While printing is in progress, 

you can select another card and add it to the printer spool that is being printed, or 

select a new printer to print. 

  



2024. 11 

~ 26 ~ 

4 Data Import From/Export To 

In addition to entering card data directly, you can also import a large amount of data at once 

through Excel/SQLite DB/CSV files. 

 

4.1 Import From 

 

<FIGURE> 28 - IMPORT FROM IN THE DATABASE MENU ON FILE TAB 

You can import or export a database from the "Database" menu in the "File" tab. 

Import supports 3 types of databases (DB/EXCEL/TXT, CSV). 

 

4.1.1 Import From Excel 

When importing from EXCEL, the first column of the Excel file is recognized as a field, 

and columns from the second column onwards are recognized as data. 

When “Binding Save” button is clicked after connecting input fields to EXCEL field, the 

information about connecting fields is saved as a file (.bnd). If the updated EXCEL file is 

imported next time, you can import that information by clicking ‘Binding Import’ button 

at once. 
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<FIGURE> 29 - IMPORT FROM EXCEL WINDOW  

 

There are 3 ways to Import images. 

1) Internal Path in Project 

When the image file to be loaded is in the project folder. 

 

<FIGURE> 30 - IMAGE FILE LOCATED IN THE PROJECT FOLDER  
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<FIGURE> 31 - FILE NAME WRITTEN IN THE EXCEL FILE (LOCATED IN THE PROJECT FOLDER)  

When loading data, the project folder is searched first, so if you enter the exact “file 

name” for the image, the image will be loaded. 

2) Relative Path 

If the image file in the same location as the project folder or in a parent folder. 

 

<FIGURE> 32 - IMAGE FILE LOCATED IN THE PARENT FOLDER OF THE PROJECT FOLDER  

Enter a relative path to where the image is located, the image matching the image “file 

name” will be loaded based on the project folder. 
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<FIGURE> 33 - IMAGE FILE PATH WRITTEN IN THE EXCEL FILE  

If you have created a separate image folder within the project folder, you can load the 

image by entering the folder name. 

3) Specified Path 

If the image files in a path unrelated to the project folder location. 

 

<FIGURE> 34 - FILE NAME WRITTEN IN EXCEL (NOT EXISTING IN THE PROJECT FOLDER)  

Enter only the “File name” in the data if there are no images with the same file name in 

the project folder. 

 

<FIGURE> 35 - IMAGE PATH SETTING POPUP  
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<FIGURE> 36 - FOLDER SELECTION WINDOW  

In this case, a window will open to select a folder after the confirmation pop-up 

message to set the image path. Select the location where the image folder and click the 

"OK" button to will be load the images. 

 

<FIGURE> 37 – CELL FORMAT WINDOW  

The "Cell Format" is you to change formatted data, such as date/time, to a desired 

format. 

In the "Cell Format" window, select the data field and format you want to use and click 

the "Set" button to change the data in the Excel file. 
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<FIGURE> 38 - FORMATTED CELL DISPLAY  

 

4.1.2 Import From DB 

 

<FIGURE> 39 - DATABASE IMPORT WINDOW  

When you click the "DB (Import data from DB)" button, a window will pop up allowing 

you to select a .db file. 

The "Import DB" window displays the internal data of the DB file, and if you match the 

CSD field to the DB field, it will be bound. Select all the data you want to import and 

click the "Import" button, and the selected data will be entered into the "Database" tab 

sheet of SMART IDesigner. 



2024. 11 

~ 32 ~ 

4.1.3 Import From TXT, CSV 

 

<FIGURE> 40 - IMPORT FROM TEXT WINDOW  

When you click the "TXT, CSV (Import data from TXT, CSV)" button, a window will pop 

up allowing you to select a .txt or .csv file. 

The "Import Text" window displays the internal data of the file, and if you match the CSD 

field to the DB field, it will be bound. Select all the data you want to import and click the 

"Import" button, and the selected data will be entered into the "Database" tab sheet of 

the SMART IDesigner. 
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4.2 Export To 

The “Export to” is you to convert card data existing in the “Database" tab of the SMART IDesigner 

into a SQLite DB file or Excel file and save it as a file. 

4.2.1 Export To Excel 

 

<FIGURE> 41 - EXPORT TO IN THE DATABASE MENU ON THE FILE TAB  

You can export to "DB" or "Excel" by clicking the "Export to" button in the Database 

menu of the "File" tab. 

 

<FIGURE> 42 – EXPORT TO EXCEL WINDOW  
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To export to "Excel", select all the data you want to export in the "Export to Excel" 

window and click the "Export" button. 

 

<FIGURE> 43 – FOLDER WHERE EXPORTED IMAGES ARE SAVED  

Choose the save location, enter the file name, and click OK, an Excel file will be created 

and a "Project Name_Image" folder containing the image will be created in the project 

folder. 

 

4.2.2 Export To DB 

 

<FIGURE> 44 – EXPORT TO DB WINDOW  

To export to "DB", select all the data you want to export in the "Export to DB" window 

and click the "Export" button. 

Choose the save location, enter the file name, and click OK, will be created and a "SQLite 

DB" files containing the image. 
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5 Encoding 

SMART IDesigner supports data encoding on magnetic cards, contact/contactless smart cards. 

It is possible when using a printer equipped with an encoder, and the following settings are required 

for encoding. 

5.1 MS Encoding 

 

<FIGURE> 45 - MAGNETIC FIELD SETTING IN THE FIELDS MENU ON PLUGIN TAB  

To activate the MS encoding, go to the "Plugin" tab in the menu bar. 

When you click the "Magnetic Card Encoding" to activate MS Encoding, the Magnetic Setup 

window will pop up allowing you to change encoding options.  

To edit the encoding options, click the "Magnetic Field Setting". 

To deactivate the MS encoding, click the "Magnetic Card Encoding" again. 

5.1.1 Toggle Cell Grouping 

 

<FIGURE> 46 - CELL GROUPING IN THE MAGNETIC FIELD SETTINGS WINDOW  

There are two ways to enter magnetic encoded data. Use to linked data to the 

“Database” tab fields, direct entering designated text or you can use a mix of these. 
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5.1.2 Set Whole Field 

 

<FIGURE> 47 - INPUT FIELD CONFIGURATION IN THE MAGNETIC FIELD WINDOW  

Check the track you want to use to activate it. 

You can drag the cell to the data length you want to use and right-click to make a 

group or select the input fields in the database. 

 

<FIGURE> 48 – SCREEN WHERE ALL CELLS OF THE TRACK ARE LINKED WITH FIELDS  

When you select an input field, a list of CSD fields will be displayed and you can link 

them to the selected Track. When a field is linked, the cell will turn yellow and the field 

name will be displayed. 
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5.1.3 Set Field + Text 

 

<FIGURE> 49 - SCREEN WHERE FIELDS AND TEXT ARE SET TOGETHER ON THE TRACK  

You can use fields with designated text by dragging to select the cells and entering text 

in the remaining space. 

 

5.1.4 Set Multiple Fields 

 

<FIGURE> 50 - SCREEN WITH MULTIPLE FIELDS SET ON THE TRACK  

You can use two or more fields together in the same way, and data will be entered 

according to the length of the set cell, regardless of the data length. 
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5.2 Contactless Card Encoding 

 

<FIGURE> 51 – CONTACTLESS CARD ENCODING MENU ON PLUGIN TAB 

To activate the Contactless Card Encoding, go to the “Plugin” tab in the menu bar. 

There are two types of Contactless Card Encoding: "Contactless Card Encoding" in the 

Contact/Contactless Card Encoding section, and "User-Defined Contactless Card Encoding" in the 

User-Defined Card Encoding section. 

5.2.1 Contactless Card Encoding 

 

<FIGURE> 52 - CONTACTLESS CARD ENCODING IN THE CONTACT/CONTACTLESS CARD ENCODING AREA 

"Contactless Card Encoding" in the Contact/Contactless Card Encoding section is to use 

a built-in contactless card encoding function. 

Click the "Contactless Card Encoding" to activate Contactless Card Encoding. The Default 

Encoding Field Settings window will pop up allowing you to change encoding options. 

To edit the encoding options, click "Encoding Field Settings". 

To deactivate the Contactless Card Encoding, click the "Contactless Card Encoding" again 

or leave the input and output unset in the Fields Setting window. 
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<FIGURE> 53 - DEFAULT ENCODING FIELD SETTINGS WINDOW: CONTACTLESS CARD ENCODING MODE 

The Default Encoding Field Settings allows you to set Encoding type, Card Type, Start 

block, End block and Field Setting (Field Name, Input, Output, and Output Data Type). 

When you set the Input checkbox, it encodes data from the value of database field to 

the contactless chip. 

When you set the Output checkbox, it reads the ATR of the card and save it to the 

selected database field. 

 

1) URL Mode 

This mode is exclusively available for NTAG cards. It encodes a URL, allowing 

smartphones to navigate to the encoded URL when tapping the NFC tag. 
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2) Proceed after formatting 

Erases all data currently encoded on the card before proceeding with new encoding. 

3) Progress Display/No Progress Display 

Displays a popup showing the progress during formatting, which can be toggled on or 

off. 

4) Skip electricity supply 

If checked, RF or IC ON/OFF operations are not performed when using custom card 

encoding. 

 

5.2.2 User-Defined Contactless Card Encoding 

 

<FIGURE> 54 – USER-DEFINED CONTACTLESS CARD ENCODING IN THE USER-DEFINED CARD ENCODING AREA 

"User-Defined Contactless Card Encoding" allows you to use the contactless card 

encoding libraries (.dll file) developed by user. 

Click the "User-Defined Contactless Card Encoding" to select the plugins developed by 

user. The User Encoding Field Settings window will pop up allowing you to change 

encoding options. 

To edit the encoding options, click "User-Defined Encoding Field Settings". 

To deactivate the User-Defined Contactless Card Encoding, click the “User-defined 

Contactless Card Encoding” again or leave the input and output unset in the Fields 

Setting window. 
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<FIGURE> 55 – USER ENCODING FIELD SETTINGS WINDOW: CONTACTLESS CARD ENCODING MODE 

The User Encoding Field Settings allows you to set Encoding type, Card Type, Start block, 

End block and Field Setting (Field Name, Input, Output, and Output Data Type). 

When you set the Input checkbox, it encodes data from the value of database field to 

the contactless chip. 

When you set the Output checkbox, it reads the ATR of the card and save it to the 

selected database field. 

 

5.3 Contact Card Encoding 

 

<FIGURE> 56 - CONTACT CARD ENCODING MENU ON PLUGIN TAB 
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To activate the Contact Card Encoding, go to the “Plugin” tab in the menu bar. 

There are two types of Contact Card Encoding: "Contact Card Encoding" in the 

Contact/Contactless Card Encoding section, and "User-Defined Contact Card Encoding" in the 

User-Defined Card Encoding section. 

5.3.1 Contact Encoding 

 

<FIGURE> 57 - CONTACT CARD ENCODING IN THE CONTACT/CONTACTLESS CARD ENCODING AREA 

"Contact Card Encoding" in the Contact/Contactless Card Encoding section is to use a 

built-in contact card encoding function. 

Click the "Contact Card Encoding", INFO window will pop up stating that Contact Card 

Encoding is only for ATR output. 

 

<FIGURE> 58 - CONTACT CARD ENCODING GUIDE POPUP 

Click the "OK" button. The Default Encoding Field Settings window will pop up allowing 

you to change encoding options. 

To edit the encoding options, click the “Encoding field settings”. 

To deactivate the Contact Card Encoding, click the “Contact Card Encoding” again or 

leave the input and output unset in the Fields Setting window. 
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<FIGURE> 59 - DEFAULT ENCODING FIELD SETTINGS WINDOW: CONTACT CARD ENCODING MODE 

The Default Encoding Field Settings allows you to set Encoding type, Card Type, Start 

block, End block and Field Setting (Field Name, Input, Output, and Output Data Type). 

The Input checkbox doesn’t work on Contact Card Encoding.  

When you set the Output checkbox, it reads the ATR of the card and save it to the 

selected database field. 

 

5.3.2 User-Defined Contact Card Encoding 

 

<FIGURE> 60 - USER-DEFINED CONTACT CARD ENCODING IN THE USER-DEFINED CARD ENCODING AREA 
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"User-Defined Contact Card Encoding" allows you to use the contact card encoding 

libraries (.dll file) developed by user. 

Click the "User-Defined Contact Card Encoding" to select the plugins developed by user. 

The User Encoding Field Settings window will pop up allowing you to change encoding 

options. 

To edit the encoding options, click "User-Defined Encoding Field Settings". 

To deactivate the User-Defined Contact Card Encoding, click the “User-defined Contact 

Card Encoding” again or leave the input and output unset in the Fields Setting window. 

 

<FIGURE> 61 - USER ENCODING FIELD SETTINGS WINDOW: CONTACT CARD ENCODING MODE 

The User Encoding Field Settings window allows you to set Encoding type, Card Type, 

Start block, End block and Field Setting (Field Name, Input, Output, and Output Data 

Type). 
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When you set the Input checkbox, it encodes data from the value of database field to 

the contact chip. 

When you set the Output checkbox, it reads the ATR of the card and save it to the 

selected database field. 
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6 Tab and Feature Descriptions 

SMART IDesigner consists of menu tab, ribbon bar, drawing and properties area as shown the Figure 

55. 

 

<FIGURE> 62 - SMART IDESIGNER TAB & RIBBON BAR  

Menu consists of “File”, “Home”, “Drawing”, “Edit”, “View”, “Option”, “Database” and “Help”. When 

clicking “Menu”, the ribbon bar related to Menu will be shown.    

When SMART IDesigner is run, “Home” ribbon bar will be shown basically. There are essential tools in 

“Home” in order to use SMART IDesigner. For further information for each ribbon bar, please refer to 

the follow chapter.    

Drawing area allows you to edit various objects such as rectangle, circle, line, image, text and barcode 

on the card with CR-80 (54mm x 86mm) size on the screen.  

Properties area allows you to see the properties of selected objects in detail and edit conveniently. 

6.1 File Tab 

6.1.1 New Project/Template/Open/Save/Save As 

 

<FIGURE> 63 - FILE TAB MENU COLLECTION 1 

 New Project : To create a new card design, click the "New" button. Please refer 

to the 3.1.2 for details. 
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 Template : To create a new card design using a design template, click the "New 

Template" button. Please refer to the 3.1.1 for details. 

 Open : Click the “Open” button to select a project or design file and open it.  

When selecting a CSP file, all files for project in same directory is open. But, if a 

CSD file is selected, only design file is open. When opening the CSD file, new 

project will be saved later. The CSP file of Smart ID was used as a database by 

the MDB file. When opening older versions of CSP files in SMART IDesigner, you 

can convert them to an improved database, SQLite DB. 

 Save : When clicking “Save” button, active project is saved. When starting with 

“New Project” or “Open CSP file”, the project is saved in the appointed location 

automatically. When not creating project or using “Open CSD file”, “New Project” 

window will be shown and saved as new project. 

 Save As : When clicking “Save as” button, active file will be saved with new 

name. 
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6.1.2 Print Setup/Print/Database/Recent Project/Print History/Exit 

 

<FIGURE> 64 - FILE TAB MENU COLLECTION 2 

 Print Setup : The properties for printing such as printing direction, ribbon 

option, etc. are set up. Refer to the printer driver manual for detailed 

information. 

 Print : When clicking “Print” button, design is printed by card printer. This 

printing is used to check the status of design. When printing a large number of 

cards through database, “Print” button of “Database” menu is used. 

 Database : “Database” is used to import external data or export data of project. 

SMART IDesigner can use data of DB or XLS type. 

 Recent Project : Open the log that records the printing history from 

C:\smartlog\PrintLog. The log saved a monthly history of printing in files 

named like YYYYMM.log. 

 Print History : The list of the latest projects will be shown. 

 Exit : When clicking “Exit” button or [X] button of window, SMART IDesigner is 

closed. When there is a change in design or database, the question about 

whether saving a current project or not will be displayed. 
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6.2 Home Tab 

6.2.1 Project 

 

<FIGURE> 65 – PROJECT MENU ON HOME TAB 

1) Save 

Active project is saved. The project have CSD, CSP, DB files for SMART IDesigner 

program. 

2) New 

New project is begun. When creating a new project, directory to be saved is set by 

project name and directory. 

3) Open 

Project file (.CSP) or Design file (.CSD) is imported. When opening a CSP file, card can be 

issued promptly because design and database in project are open together. If opening 

only a CSD file, database-related functions are not available. 

In case of the CSP file which is created in Smart ID, the MDB file is used as the database. 

When the CSP file of Smart ID is opened, the enhanced database, it can be converted to 

SQ List DB file. 

4) Print 

The design is printed by card printer. 

“Print” is used to check the design. When printing by linking to database, “Print” of 

“Database” tab should be pressed. 
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6.2.2 Font 

 

<FIGURE> 66 – FONT MENU ON HOME TAB 

1) Font List 

Select the font type or the barcode type. You can see all possible font types in Windows 

or all barcode lists supported in this program. 

2) Font Size 

Set the font size of text object or barcode object. 

3) Bold 

Make a bold font. It is activated when the text object is selected. Click the icon or press 

“Ctrl” key with “B” key to make font bold. 

4) Italic 

Make an italic font. It is activated when the text object is selected. To make an italic 

effect, click the icon or press “Ctrl” with “I” key. 

5) Underline 

Underline a font. It is activated when the text object is selected. To make an underline 

effect, click the icon or press “Ctrl” with “U” key. 

6) Font Color 

Set the font color of the text object or the barcode color of the barcode object. If click 

the left side of icon, the color is applied. If press the right downside arrow. You can 

select the desired color to apply to the text object or barcode object. 

7) Point Size Setting 

The default font size is set to 1px x 1pt. You can change the setting. 
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6.2.3 Paragraph 

 

<FIGURE> 67 – PARAGRAPH MENU ON HOME TAB 

1) Left Alignment 

Text is aligned on the left side. If the text box width is shorter than the characters, the 

characters on the right side that over the width will not be shown. 

2) Horizontal Center Alignment 

Text is aligned on the center. If the text box width is shorter than the characters, the 

characters on the right side that over the width will not be shown. 

3) Right Alignment 

Text is aligned on the right side. If the text box width is shorter than the characters, the 

characters on the right side that over the width will not be shown. 

4) Justified Alignment 

Text is aligned on the same distance between the characters. 

5) Top Alignment 

Text is aligned on the top side. If the text box vertical width is shorter than the 

characters, the characters on the below side that over the vertical width will not be 

shown. 

6) Vertical Center Alignment 

Text is aligned on the middle. If the text box vertical width is shorter than the characters, 

the characters above and below side on the right side that over the vertical width will 

not be shown. 

7) Bottom Alignment 

Text is aligned on the bottom side. If the text box vertical width is shorter than the 

characters, the characters on the above side that over the vertical width will not be 

shown. 
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6.2.4 Drawing 

 

<FIGURE> 68 – DRAWING MENU ON HOME TAB 

1) Rectangle Tool 

Draw a rectangle. If you select this icon, the cursor will be changed to  shape. The 

object is set as color panel. If the current document cannot use a color panel, it will be 

set to a black and white panel. 

2) Ellipse Tool 

Draw an oval. If you select this icon, the cursor will be changed to  shape. The object 

is set as color panel. If the current document cannot use a color panel, it will be set to a 

black and white panel. 

3) Round Rectangle Tool 

Draw a rounded rectangle. If you select this icon, the cursor will be changed to  shape. 

The object is set as color panel. If the current document cannot use a color panel, it will 

be set to a black and white panel. 

4) Line Tool 

Draw a straight line. If you select this icon, the cursor will be changed to  shape. The 

object is set as color panel. If the current document cannot use a color panel, it will be 

set to a black and white panel. 

5) Image Tool 

Insert an image. Select the image when the image selecting dialog box is open. The 

object is set as color panel. If the current document cannot use a color panel, it will be 

set to a black and white panel. Right-clicking on the image shape and selecting the 

"Change Image" menu will popup a file explorer. 

6) Text Tool 

Make a text box. Input text when text input dialog box is open. The object is set as black 

panel. You can edit the content by right-clicking on the text shape and selecting the 

'Edit' menu. 

7) 1D Barcode Tool 

Make a barcode. Input data when data input dialog box is open. The object is set as 

black panel. You can change the data by right-clicking on the text shape and selecting 

the “Revise” menu. 
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8) 2D Barcode Tool 

Make a 2D barcode. The method of data input is same as barcode. 

    

<FIGURE> 69 – ALIGNMENT MENU ON HOME TAB 

9) Move To Top 

Move the selected object to the top. 

10) Move To Front 

Move the selected object to one step up. 

11) Move To Back 

Move the selected object to one step down. 

12) Move To Bottom 

Move the selected object to bottom. 

13) Left Align 

Align the selected objects to the left of standard object. 

14) Right Align 

Align the selected objects to the right of standard object. 

15) Top Align 

Align the selected objects to the top of standard object. 

16) Bottom Align 

Align the selected objects to the bottom of standard object. 

17) Align Same Width 

Align the distance of the selected objects in horizontally same distance. 
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18) Align Same Height 

Align the distance of the selected objects in vertically same distance. 

19) Horizontally Center Align 

Move the selected objects to the horizontal center. 

20) Vertical Center Align 

Move the selected objects to the vertical center. 

21) 90 degrees Clockwise 

Rotate the selected objects 90 degrees clockwise. 

22) 90 degrees Counterclockwise 

Rotate the selected objects 90 degrees counterclockwise. 

23) 180 degrees Rotate 

Rotate the selected objects 180 degrees counterclockwise. 

24) Horizontally Flip 

Reverse the selected objects right and left. 

25) Vertically Flip 

Reverse the selected objects upside down. 

26) Object Fill 

Set the background color of the selected object. Click the left part of the button to apply 

the last used fill value to the selected object (this is reset when the program starts). If 

click the right downside arrow, you can see the color table popup. 

27) Object Border 

Set the outline color of the selected object. Click the left part of the button to apply the 

last used border value to the selected object (this is reset when the program starts). click 

the right downside arrow, you can see the color table popup. 
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6.2.5 Panel 

 

<FIGURE> 70 – PANEL MENU ON HOME TAB 

1) Set as Color Panel 

Set as color panel for the selected object. If the installed ribbon is not color ribbon, this 

icon will not be activated. When the object is set as color panel, the blue color is applied 

to the object. 

2) Set as Black Panel 

Set as black panel for the selected object. Text and barcode are set as black panel at 

default. The background, outline and font will be changed to gray color. For the image 

object, the dithering effect will be applied. If the object is set as black panel, the square 

of outline will be black color. 

3) Set as Overlay Panel 

If you click Overlay Panel icon after select the object, overlay will not be applied to that 

object. The Image, text and barcode are not overlaid if this icon is clicked. When the 

object is set as overlay panel, the square of outline will be changed to gray color. 

4) Set as Fluorescent Panel 

If you click Fluorescent Panel icon after select the object, fluorescent will be applied to 

that object. The Image, text and barcode are fluoresced if this icon is clicked. Fluorescent 

panels are available only if the ribbon used by your printer include a fluorescent panel. 

When the shape is set to Fluorescent Panel, the color of the selection box will be white. 

5) Display Color Panel 

You can see all objects which are set as color panel. 

6) Display Black Panel 

You can see all objects which are set as black & white panel. 

7) Display Overlay Panel 

All overlay panels can be seen. The overlaid area will be displayed darker than not 

overlaid area. 

8) Display Fluorescent Panel 

All fluorescent panels can be seen. The fluoresced area will be displayed more blue 

printed than not fluoresced area. 
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6.2.6 Invert 

 

<FIGURE> 71 - INVERT MENU ON HOME TAB 

1) Invert Overlay Panel 

Basically, overlay is supplied to all surface of card. In case of the text, drawing and image 

object, the contents will not be overlaid. If you want to invert this, click this icon. 

2) Invert Fluorescent Panel 

The fluorescent panel is set to not print the entire side of the card by default. When you 

select text, a drawing shape, or an image shape on the fluorescent panel, the area that is 

highlighted in blue will be printed on the fluorescent panel. If you want to invert this, 

click this icon. 

 

6.2.7 Page 

 

<FIGURE> 72 – PAGE MENU ON HOME TAB 

1) Front Page 

This SMART card printer can print the front side and back side. It can be set by the 

printer setup. The icon will be activated when the related side is under designing.  

“Page2” is activated when the Slave printer or the laser engraver is connected. 

This SMART card printer can print the front and back.  

2) Back Page 

You can design the back side of the card using this icon. It will be activated when the 

printing setup is both-side printing. “Page2” is activated when the Slave printer or the 

laser engraver is connected. 
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6.3 Drawing Tab 

6.3.1 Font 

 

<FIGURE> 73 – FONT MENU ON DRAWING TAB 

Please refer to the Chapter 6.2.2. 

 

6.3.2 Paragraph 

 

<FIGURE> 74 – PARAGRAPH MENU ON DRAWING TAB 

Please refer to the Chapter 6.2.3. 

 

6.3.3 Drawing 

 

<FIGURE> 75 - DRAWING MENU ON DRAWING TAB 

Please refer to the Chapter 6.2.4. 

 

6.3.4 Align 

 

<FIGURE> 76 - ALIGN MENU ON DRAWING TAB 

Please refer to the Chapter 6.2.4. 



2024. 11 

~ 58 ~ 

1) Same Width Adjustment 

Change the width of the selected objects same as the standard object. 

2) Same Height Adjustment 

Change the height of the selected objects same as the standard object. 

3) Same Size Adjustment 

Change the size of selected objects same as the standard object. 

 

6.4 Edit Tab 

6.4.1 Undo/Redo 

 

<FIGURE> 77 – UNDO/REDO MENU ON EDIT TAB 

1) Undo 

Reverse the last command. Shortcut (Ctrl + Z). 

2) Redo 

Reverse the action of the “Undo”. Shortcut (Ctrl + Y). 

 

6.4.2 Clipboard 

 

<FIGURE> 78 - CLIPBOARD MENU ON EDIT TAB 

1) Paste 

Paste the cut or copied object. Shortcut (Ctrl + V). 

2) Cut 

Remove the selection from the design and place it in the clipboard. Available only in 

SMART IDesigner. Shortcut (Ctrl + X or Shift + Delete). 

3) Copy 

Copy the selected object in the clipboard. Available only in SMART IDesigner. Shortcut 

(Ctrl + C). 
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6.4.3 Selection 

 

<FIGURE> 79 – SELECTION MENU ON EDIT TAB 

1) Select All 

Select all objects in active design. Shortcut (Ctrl + A). 

2) Delete 

Delete selected object. 

3) Properties 

Double-click on the selected object or press Alt+Enter key. A window will appear. The 

contents of the object properties depend on the kind of selected object. To apply 

background color, line color, line type and line thickness to the new object created from 

now on, click the “Set the properties to the new object”. 

Please refer to the Chapter 3.2.1 for details. 

 

6.4.4 Image 

 

<FIGURE> 80 – IMAGE MENU ON EDIT TAB 

1) Contrast Up 

Contrast up to the selected image object. 

2) Sharply Contrast Up 

Sharply Contrast up to the selected image object. 

3) Contrast Down 

Contrast down to the selected image object. 

4) Sharply Contrast Down 

Sharply Contrast down to the selected image object. 

5) Brightness Up 

Brightness up to the selected image object.  
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6) Sharply Brightness Up 

Sharply Brightness up to the selected image object. 

7) Brightness Down 

Brightness down to the selected image object. 

8) Sharply Brightness Down 

Sharply Brightness down to the selected image object. 

9) Zoom In 

Zoom in the image. The zoom range can be adjusted in the “Zoom step” menu of the 

“Options” tab. 

10) Sharply Zoom In 

Sharply zoom in the image. The zoom range can be adjusted in the 'Zoom Step' menu 

of the 'Options' tab. 

11) Zoom Out 

Zoom out the image. The zoom range can be adjusted in the 'Zoom Step' menu of the 

'Options' tab. 

12) Sharply Zoom Out 

Sharply zoom out the image. The zoom range can be adjusted in the 'Zoom Step' menu 

of the 'Options' tab. 

13) Move Left 

Move the image to the left direction. The range of movement can be adjusted in the 

'Zoom Step' menu in the 'Options' tab. 

14) Sharply Move Left 

Sharply move the image to the left direction. The range of movement can be adjusted in 

the 'Zoom Step' menu in the 'Options' tab. 

15) Move Right 

Move the image to the right direction. The range of movement can be adjusted in the 

'Zoom Step' menu in the 'Options' tab. 

16) Sharply Move Right 

Sharply move the image to the right direction. The range of movement can be adjusted 

in the 'Zoom Step' menu in the 'Options' tab. 

17) Move Up 

Move the image to the upper direction. The range of movement can be adjusted in the 

'Zoom Step' menu in the 'Options' tab. 
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18) Sharply Move Up 

Sharply move the image to the upper direction. The range of movement can be adjusted 

in the 'Zoom Step' menu in the 'Options' tab. 

19) Move Down 

Move the image to the down direction. The range of movement can be adjusted in the 

'Zoom Step' menu in the 'Options' tab. 

20) Sharply Move Down 

Sharply move the image to the down direction. The range of movement can be adjusted 

in the 'Zoom Step' menu in the 'Options' tab. 

 

6.4.5 Panel 

 

<FIGURE> 81 – PANEL MENU ON EDIT TAB 

Please refer to the Chapter 6.2.5. 

 

6.4.6 Invert 

 

<FIGURE> 82 – INVER MENU ON EDIT TAB 

Please refer to the Chapter 6.2.6. 

 

6.5 View Tab 

6.5.1 View 

 

<FIGURE> 83 – VIEW MENU ON VIEW TAB 
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1) Change Ruler Display 

Select whether the display of Ruler or not. 

2) Change Grid Display 

Select whether the display of Grid dot is shown or not. 

 

 

<FIGURE> 84 – STATUS BAR 

3) Convert Status Bar 

Select whether the status bar is shown or not. Status bar shows the information of 

position of mouse cursor and explanation of ribbon bar. 

First icon considers all the selected objects as one. Display the starting point in unit of 

millimeter. 

Second icon considers all the selected objects as one. Display the width and height in 

unit of millimeter. 

Third icon displays the current position of the mouse cursor in millimeters. 

 

6.5.2 Zoom 

 

<FIGURE> 85 – ZOOM MENU ON VIEW TAB 

1) Zoom 

Show the card size you input. You can change the view ratio by entering a number in 

the input field next to the icon. 

2) Zoom In 

Zoom in the card layout. It can also use the "+" key on your keypad. 

3) Zoom Out 

Zoom out the card layout. It can also use the "-" key on your keypad. 

4) 100% Zoom 

Show the original size design. 

5) Auto Zoom 

Fit the size of design panel to the window. As the window size changes, the rate of 

“Zoon In/Out” will be changed automatically. 
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6.5.3 Panel 

 

<FIGURE> 86 – PANEL MENU ON VIEW 

Please refer to the Chapter 6.2.5. 

 

6.5.4 Page 

 

<FIGURE> 87 – PAGE MENU ON VIEW 

Please refer to the Chapter 6.2.7. 

 

6.6 Option Tab 

6.6.1 Option 

 

<FIGURE> 88 – OPTION MENU ON OPTION TAB 

1) Snap 

Make cursor move at regular interval. The "Snap" function makes it easy to align multiple 

shapes when resizing or moving them. 

2) Set Background Color 

Select the default color for background. Different colors are available for the front and 

back sides. The default background color is white. If you use a black and white ribbon 

on your printer, be careful not to print messily when specifying colors. 

3) Show Background Image 

Click to print or not background image. If you are using a black and white ribbon on 

your printer, be careful to set a background image as this may result in messy printing. 
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4) Edit Background Image 

Edit the background image. To change from background image editing mode to normal 

editing mode, click “Edit Background Image” again, or click outside of background image. 

Only one image for one side is available and it could be printed. 

 

6.6.2 Field 

 

<FIGURE> 89 – FIELD MENU ON OPTION TAB 

1) Input Field Setting 

This function is used for mass issuing like membership cards, student ID cards and 

national ID cards, etc. If you click this button, “Field Manager” window is displayed. 

 

<FIGURE> 90 - INPUT FIELD SETTING WINDOW 

Clicking the “Set Input Fields” button will open the “Field Manager” window. 
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6.6.3 Size 

 

<FIGURE> 91 - SIZE MENU ON OPTION TAB 

1) Fit Barcode to Frame 

If you click this button, it will automatically change the barcode size to fit to frame size. 

2) Fit Text to Frame 

If you click this button, it will automatically change the text size to fit to frame size. 

 

6.6.4 Config 

 

<FIGURE> 92 - CONFIG MENU ON OPTION TAB 

1) Zoom Step 

Set the change ratio for the image zoom up / down or image movement. 

1) Set Fit Barcode to Frame 

For future barcode shapes, enable or disable the "Fit Barcode to Frame" option. This 

setting will be retained even after the program is closed. 

2) Set Fit Text to Frame 

For future text shapes, enable or disable the "Fit Text to Frame" option. This setting will 

be retained even after the program is closed. 

3) 템플릿 마법사 설정 

Configure whether the Template Wizard window opens when the program is launched 

for the first time. This setting will be retained even after the program is closed. 

4) 자동 업데이트 설정 

Configure whether the program checks for the latest version and performs an automatic 

update when launched for the first time. This setting will be retained even after the 

program is closed. 
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6.6.5 Laser Engraver 

 

<FIGURE> 93 - LASER ENGRAVER MENU ON OPTION TAB 

1) Laser 

To use the laser engraver, click the "Laser" button. When the laser engraver is enabled, 

design the content on page 2 of the "Home" tab. 

Basically the laser engraver uses the default configuration values in the laser engraver. 

However, the user can configure the laser power, speed and angle on each object. If it is 

not set, the object uses the default setting value. 

 Power : Set the power of laser. The range is 0~100, it is a percentage of the 

maximum value. 

 Speed : The range is 0~1600 (mm/s), the speed of movement of the laser. 

 Angle : To support MLI(Multiple Laser Image) or CLI(Changeable Laser Image) 

function, the card is rotated and engraved. SMART-70X can support CLI, WISE-

LE can support MLI. The range is -40 ~ -20, 20 ~ 40. 
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2) Setup 

The default setting of the laser engraver is available. The values are saved in the laser 

engraver. Click the 'Laser Engraver Settings' button, and the "Laser Configuration" 

window will appear as shown below. 

 

 

<FIGURE> 94 – LASER CONFIG WINDOW 

Laser Information 

Serial Number Show a serial number of Laser engraver. 

Setup Version Show a version of configuration for Laser engraver. 

Power 

DPI Select the resolution of laser engraving between 600 dpi / and 1200 dpi. 

Power Level 

Set the power level of the laser. 

Range : 1~25  

 If the value is larger, the power level is bigger and engrave darker. 

 The below value as ‘Text’, ‘Line’, ’Image’ is changed automatically if the 

power level is changed. 

Text 

Set the power and speed when the text or barcode is engraved. 

 Range of Power is 0~100, it is a percentage of the maximum value. 

 Range of Speed is 0~1600, the speed of movement of the laser. 
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Line 

Set the power and speed when the line or figure is engraved. 

 Range of Power is 0~100, it is a percentage of the maximum value. 

 Range of Speed is 0~1600, the speed of movement of the laser. 

Image 

Set the power and speed when the portrait or logo is engraved. Image is 

expressed by gray level, the minimum and maximum value of power are 

set. 

 Range of Power is 0~100, it is a percentage of the maximum value. 

 Range of Speed is 0~1600, the speed of movement of the laser.. 

Position 

Field Size 

Set the maximum size for laser engraving.  

 Range of Field Size is 120~150, the unit is mm. 

 The size of the output is changed if Field Size is changed. 

Angle 

Set the rotation value for laser engraving. 

 Range of Angle is 0~360, the unit is degree. 

 The output is rotated as a value of Angle. 

Offset X 

Set position to the right and left properly. 

 Range of Offset X is -10~10, the unit is mm. 

 The position of output is changed by left or right depending on this 

value. 

Offset Y 

Set position to the up and down properly. 

 Range of Offset X is -10~10, the unit is mm. 

 The position of output is changed by up or down depending on this 

value. 

Galvo 

Negate Engrave after reflection of the image across a defined axis. 

Scale 
Set the scale of the image for each axis. 

 Range of Scale is 0~100, the unit is a percentage (%). 

Ellipse 

Calibrate image result in the shape of an ellipse. 

 Range of Ellipse is 0.875~1.125. 

  

 The image is deformed depending on value of Ellipse as below. 

Parallelogram 
Calibrate image result in the shape of a parallelogram. 

 Range of Parallelogram is 0.875~1.125. 
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  

 The image is deformed depending on value of Parallelogram as below. 

Trapezoid 

Calibrate image result in the shape of a trapezoid. 

 Range of Trapezoid is 0.875~1.125. 

  

 The image is deformed depending on value of Trapezoid as below 

 

 Load Default Button : Load factory configuration values in the memory of laser 

engraver. To apply it, click a ‘Store’ button. 

 Reload Button : Show the configuration values in the laser engraver Use 

“Reload” to reload the current settings while changing values. 

 Store Button : Save current values to the laser engraver. 

 Close Button : Exit a LaserConfig utility. 

 

6.6.6 Language 

 

<FIGURE> 95 - LANGUAGE MENU ON OPTION TAB 

1) Language 

Change language to use. 
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6.7 Database Tab 

6.7.1 Connection 

 

<FIGURE> 96 – CONNECTION MENU ON DATABASE TAB  

1) Connect DB 

Connect DB is used to manually connect print fields to DB fields. You can add or delete 

fields as needed. Also, the print field can be linked to new field. 

 

<FIGURE> 97 – DB MANAGEMENT WINDOW 

After clicking “Disconnect” button, when pressing “Connect DB”, “DB Management” 

window will be displayed like figure 89. CSD Field is linked to DB Field on the left side of 

window and New Field can be created and deleted on the right side of window.  

“Connect DB” is not used separately because SMART IDesigner creates DB Field and 

connects as same name when creating “Input Field”. 

2) Disconnect 

When changing the current activated field setting of DB, Input field and DB Field can be 

linked manually by clicking “Connect DB” button after pressing “Disconnect” button. 
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6.7.2 Setting 

 

<FIGURE> 98 – SETTING MENU ON DATABASE TAB 

1) Field Setting 

Field Setting is used when connecting input field to another field without adding or 

deleting field. It is same as connecting field on “Input field” window. 

 

<FIGURE> 99– MANAGE FIELD LIST WINDOW 

When clicking “Field Setting”, “Manage field list” window will be displayed as shown the 

Figure 91. In this window, DB field connected to input field is appointed. 

2) Compress and Restore 

In case that database become huge or has abnormal symptom, “Compress and Restore” 

is used to compress and recover DB file. 
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6.7.3 Security 

 

<FIGURE> 100 – SECURITY MENU ON DATABASE TAB 

1) Password 

This feature is currently not supported. 

 

6.7.4 Print 

 

<FIGURE> 101 – PRINT MENU ON DATABASE TAB 

1) Print 

The card is printed by using data entered in database. In order to print, cards to be 

printed are selected and marked as sky-blue. Then “Select Printer” window will be 

displayed as figure 94 when clicking “Print” button. Please refer to the Chapter 3.3.5. 

 

<FIGURE> 102 - PRINT QUEUE WINDOW 
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2) Print Queue 

"Print Queue" shows printer status and print information. You can check and manage 

each connected printer from the combo box in the upper left corner. 

 

6.7.5 Mark 

 

<FIGURE> 103 - MARK MENU ON DATABASE TAB 

1) Printed 

This button changes selected card to printed card. 

2) Unprinted 

This button changes selected card to unprinted card. 

 

6.7.6 Display 

 

<FIGURE> 104 – DISPLAY MENU ON DATABASE TAB 

If there is a lot of card data registered in the database, you can view all cards, printed 

cards, and unprinted cards separately through the “Display” menu. 

1) All Cards 

This button shows both printed card and unprinted card in database. 

2) Printed Cards 

This button shows only printed card in database. 

3) Unprinted Cards 

This button shows only unprinted card in database. 

 



2024. 11 

~ 74 ~ 

6.7.7 Search 

 

<FIGURE> 105 – SEARCH MENU ON DATABASE TAB 

1) Printed 

This button searches for and selects the nearest "printed card" among the cards 

following the currently selected card. 

2) Unprinted 

This button searches for and selects the nearest "unprinted card" among the cards 

following the currently selected card. 

3) Text 

When clicking “Text” button, “Search String” window will be displayed as shown the 

Figure 98. 

 

<FIGURE> 106 – SEARCH STRING WINDOW 

When entering the desired text in “Search String” window and clicking “Search” button, 

cursor moves to the card including inputted string. 

4) Position 

When clicking “Position” button, “Search Position” window will be displayed as shown 

the Figure 99. 

 

<FIGURE> 107 – SEARCH POSITION 

When entering the desired location in “Search Position” window and clicking “Search” 

button, cursor moves to the designated location. 
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6.7.8 Card 

 

<FIGURE> 108 – CARD MENU ON DATABASE TAB 

1) Add 

When clicking “Add” button, “Add Card” window will be shown to enter new card data. 

Enter each field data in “Add Card” window. 

2) Edit 

When clicking “Edit” button, “Edit Card” window appears to modify the position of card. 

Data is modified on “Edit Card” window. 

3) Delete 

When clicking “Delete” button, the selected card is deleted. 
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6.8 Plugin Tab 

6.8.1 Image Capture 

 

<FIGURE> 109 – IMAGE CAPTURE MENU ON PLUGIN TAB 

1) Image Capture 

 

<FIGURE> 110 – LIST OF IMAGE CAPTURE PLUGIN 

Click “Image Capture” button to expand the built-in image capture options. 

 

<FIGURE> 111 - IMAGE CAPTURE PLUGIN USAGE SCREEN 

After selecting a built-in image capture option, you can use it through the 2nd button in 

the Add/Edit Card. 

2) User-defined Image Capture 

Click “User-defined Image Capture” button to expand the image capture options 

developed by user. 
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After selecting one of User-defined image capture options, you can use it through the 

2nd button in the Add/Edit Card. 

 

6.8.2 Magnetic Card Encoding 

 

<FIGURE> 112 – MAGNETIC CARD ENCODING MENU ON PLUGIN TAB 

1) Magnetic Stripe Setting 

Magnetic Setup window will pop up allowing you to set MS encoding options. (Refer to 

section 5.1). 

2) Magnetic Card Encoding 

Activate/deactivate the MS encoding function. 

 

6.8.3 Contact/Contactless Card Encoding 

 

<FIGURE> 113 – CONTACT/CONTACT LESS CARD ENCODING MENU ON PLUGIN TAB 

1) Encoding Field Settings 

Default Encoding Field Settings window will pop up allowing you to set a built-in 

Contact or Contactless card encoding options. (Refer to the section 5.2.1, 5.3.1) 

2) Contact Card Encoding 

Activate/deactivate the built-in Contact card encoding function. 

3) Contactless Card Encoding 

Activate/deactivate the built-in Contactless card encoding function. 
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6.8.4 User-Defined Card Encoding 

 

<FIGURE> 114 – USER-DEFINED CARD ENCODING MENU ON PLUGIN TAB 

1) User-Defined Card Encoding Field Setting 

User Encoding Field Settings window will pop up allowing to set User-Defined Contact or 

Contactless card encoding options. (Refer to section 5.2.2, 5.3.2) 

2) User-Defined Contact Card Encoding 

Activate/deactivate the user-defined contact card encoding function. 

3) User-Defined Contactless Card Encoding 

Activate/deactivate the user-defined contactless card encoding function. 
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6.9 Help Tab 

6.9.1 Help 

 

<FIGURE> 115 – HELP MENU ON HELP TAB 

1) About 

When clicking this button, program version, information, etc. will be shown. 

2) Help 

When clicking this button, SMART IDesigner user manual will be open. Requires Adobe 

Acrobat Reader or a program capable of viewing PDF documents. 
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7 Docking Panel 

7.1 Object Properties 

 

<FIGURE> 116 - OBJECT PROPERTIES 

Properties Grid is “Object Properties” window on the right side of main window. You can see and 

modify the properties of selected object. 
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7.1.1 Base Category 

 

<FIGURE> 117 - BASE CATEGORY 

It shows the information of position and color of object in Base Category. If several 

objects are selected and properties are different, the value is not displayed. If the value 

is modified in Properties Grid, selected objects are applied. 

1) Base 

 Page : It shows the page where selected object is. Read only. 

 Panel : It shows the panel which selected object is printed on. 

 Object Fixed : Used to fix or unfix objects. 

2) Position 

 Left : It means the distance from the left side of background to the object. The 

unit is dot, and the number of horizontal dots is 1012. 

 Top : It means the distance from the top side of background to the object. The 

unit is dot, and the number of vertical dots is 636. 

 Width : It means the width of the object. The unit is dot. 

 Height : It means the Height of the object. The unit is dot. 

 Rotate : It shows the value of angle of the object. Unit is 90 degrees. You can 

select the value among 0, 90, 180, 270 degrees. Rotates around the center point 

of the shape, and for image shapes, also rotates the size and offset values. 

3) Border 

 Style : It shows the line style selected. 
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 Width : It shows the line width selected. If Style is “no border”, you can’t 

change the value. 

 Color : It shows the line color selected. If Style is “no border”, you can’t change 

the value. 

4) Background 

 Fill : It designates whether background color is filled or not. 

 Color : It shows the background color. If “Background-Fill” is False, the value 

cannot be modified. 

5) Laser 

 Power : Enter the laser power in %. 

 Speed : Enter the laser engraving speed in mm/s. The range is 1 to 1600. 

 Angle : Specifies the angle to rotate for engraving MLI (Multiple Laser Image) or 

CLI (Changeable Laser Image). Each range is -40 to -20 and 20 to 40. 

 

7.1.2 Extended Category – Round Rectangle 

 

<FIGURE> 118 - EXTENDED CATEGORY: ROUND RECTANGLE 

If the selected object is rounded rectangle, it shows the properties of rounded rectangle. 

 Corner Round : It shows the value of edge in Rounded Rectangle. Unit is % and 

range is 1~100. If the value if 0, object shape is rectangle. If the value is 100, 

the short part of width or height is rounded without line. 
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7.1.3 Extended Category – Image 

 

<FIGURE> 119 - EXTENDED CATEGORY : IMAGE 

1) Size 

 Original Width : It shows the width size of the original image. Read only. 

 Original Height : It shows the height size of the original image. Read only. 

2) Effect 

 Auto Effect : It shows whether Auto Effect is applied or not. Auto Effect is the 

function to adjust the brightness and contrast in a picture automatically. If the 

value is true, brightness and contrast is adjusted properly. Default is false. 

 Contrast : It shows the value of Contrast. Range is -100 ~ 100. Default is 0. If 

the value is increased, image color changes primary color. If the value is 

decreased, image color changes gray color. If Auto Effect is True, this value is 

not applied. If you change this value when Auto Effect is True, the value is 

applied and Auto Effect changes False. 

 Brightness : It shows the value of Brightness. Range is -255 ~ 255. Default is 0. 

If the value is increased, image color changes white. If the value is decreased, 

image color changes black. If Auto Effect is True, this value is not applied. If you 

change this value when Auto Effect is True, the value is applied and Auto Effect 

changes False. 

 Opacity : Shows the transparency of the selected image shape. This value can 

be adjusted from 0 to 100%, with 0% making the image completely transparent. 



2024. 11 

~ 84 ~ 

 Color Mode : It shows the mode of color. You can select Color and Grayscale. 

Default is Color. If Auto Effect is True, this value is not applied. If you change 

this value when Auto Effect is True, the value is applied and Auto Effect changes 

False. 

3) Zoom & Position 

 Auto Portrait : Auto Portrait is the function to find the face in the Image 

automatically.  If the value is true, the image is focused on the face and 

adjusted the size and position properly. Default is false. 

 Scaling : It shows the mode of zoom. If you set Auto Portrait, this value is 

changed to “User Set”. Default is “Fit to Width of Frame”. 

 Width Zoom : It shows the ratio of width of the image. 

 Height Zoom : It shows the ratio of height of the image. 

 Horz. Align : It shows the mode of Horizontal alignment. If this value is “Left”, 

image shows from the left side in the frame. If this value is “Right”, image 

shows from the right side in the frame. If this value is “Center”, image shows on 

the center in the frame. The value of “Inside Left Offset” depends on this value. 

Default is Center. 

 Vert. Align : It shows the mode of Vertical alignment. If this value is “Top”, 

image shows from the top side in the frame. If this value is “Bottom”, image 

shows from the bottom in the frame. If this value is “Middle”, image shows on 

the middle in the frame. The value of “Inside Top Offset” depends on this value. 

Default is Middle. 

 Inside Left Offset : It means the left offset value of start position of image in 

the frame. 

 Inside Top Offset : It means the top offset value of start position of image in 

the frame. 

4) Etc. 

 Corner Round : It shows the value of edge in image. Unit is % and range is 

1~100. If the value if 0, object shape is rectangle. If the value is 100, the short 

part of width or height is rounded without line. 

 Field : It shows the field connected to image. If field is already connected to 

other text or barcode when the field is changed, you can’t connect that field. 
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7.1.4 Extended Category – Text 

 

<FIGURE> 120 - EXTENDED CATEGORY : TEXT 

1) Inner Space 

 Inner Left Space : It shows the value of inner left space of text in the frame. 

 Inner Top Space : It shows the value of inner top space of text in the frame. 

 Inner Right Space : It shows the value of inner right space of text in the frame. 

 Inner Bottom Space : It shows the value of inner bottom space of text in the frame. 

2) Align 

 Horz. Align : It shows the mode of Horizontal alignment. If this value is “Left”, text 

shows from the left side in the frame. If this value is “Right”, text shows from the 

right side in the frame. If this value is “Center”, text shows on the center in the 

frame. If this value is “Justify”, text shows on the same distance between the 

characters. Default is Center. 

 Vert. Align : It shows the mode of Vertical alignment. If this value is “Top”, text 

shows from the top side in the frame. If this value is “Bottom”, text shows from the 

bottom in the frame. If this value is “Middle”, text shows on the middle in the frame. 

Default is Middle. 

3) Option 

 Auto Size : It shows whether Auto Size is applied or not. If this value is True, text 

size will automatically change the size to fit to frame size. 

4) Font 

 Font : It shows and changes the font type, style and size of text. 

 Color : It shows and changes the font color of text. 
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5) Data 

 Text : It shows the content of text. 

 Field : It shows the field connected to text. If field is already connected to other 

image when the field is changed, you can’t connect that field. 

 

7.1.5 Extended Category – Barcode 

 

<FIGURE> 121 - EXTENDED CATEGORY : BARCODE 

1) Barcode 

 Type : It shows the type of barcode. If the barcode is 1D type, you can’t change 2D 

barcode type. If the barcode is 2D type, you can’t change 1D barcode type. 

 Size : It shows the size of barcode. 

 Color : It shows the color of barcode. 

2) Parameter 

 Parameter 1 : It shows the value of “option 1” if the barcode type is 2D. It is 

inactivated if the barcode type is 1D. This means of value depends on 2D barcode 

type. 

 Parameter 2 : It shows the value of “option 2” if the barcode type is 2D. It is 

inactivated if the barcode type is 1D. This means of value depends on 2D barcode 

type. 

3) Option 

 Show Digit : It shows whether text of barcode is shown or not. It is inactivated if 

the barcode type is 2D. If the value is changed to “Show”, text is displayed on the 

bottom of barcode. 
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 Auto Size : It shows whether Auto Size is applied or not. If this value is True, 

barcode size will automatically change the size to fit to frame size. 

 Start Code : It shows the “Start Code” if the barcode type is Codabar. It is 

inactivated if the barcode type is not Codabar. 

 Stop Code : It shows the “Stop Code” if the barcode type is Codabar. It is 

inactivated if the barcode type is not Codabar. 

4) Data 

 Data : It shows the data of barcode. 

 Zip Code : It shows the zip code if the barcode type is Maxicode. Max size is 15 

characters. 

 Field : It shows the field connected to barcode. If field is already connected to other 

image when the field is changed, you can’t connect that field.  
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8 Additional 

8.1 Backup 

 

<FIGURE> 122 – BACKUP NOTIFICATION POPUP 

If the program terminates abnormally, this pop-up will appear when you reload the 

project. 

 

<FIGURE> 123 - BACKUP FILE SELECTION WINDOW 

 Current Folder : The Current Folder shows a temporary file with the date and 

time of modification of the work in progress before the abnormal termination. 

 Backup Folder : The backup folder shows files with the date and time of the file 

when the project file was first opened before the abnormal termination. 
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9 Plugin 

Other functions besides basic functions in SMART IDesigner are supported as Plugin type. 

If you make a file according to SMART IDesigner plugin regulation, the plugin can be used in SMART 

IDesigner. 

 

9.1 Overview 

You can use any name for plugin file but the extension type should be “.dll”.  

If you copy plugin files in C:\Program Files (x86)\SmartID\Plugin” folder where SMART 

IDesigner is installed in, and restart SMART IDesigner, you can use the plugin in SMART IDesigner 

program. 

The default installation path is as follows. 

 C:\Program Files (x86)\Smart IDesigner\Plugin\User 

 C:\Program Files\Smart IDesigner\Plugin\User 

 

9.2 Plugin Development 

You can develop plugins as “DLL” type.  

There are some regulations for developing plugin and you must follow the regulations. 

9.2.1 Parameters and Return Values 

The plugin uses the following functions; 

Mandatory 

int WINAPI GetPluginInfo(PLUGIN_INFO* pInfo) 

int WINAPI StartPlugin(HANDLE hDone, PLUGIN_DATA* 

pInput) 

int WINAPI EndPlugin() 

Optional int WINAPI GetPluginCardData (CStringArray* cardList) 

 

The header files,“PluginDLL.h” and “pluginHeader.h” in the “Plugin” folder defines related 

functions and structures. 
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The below is the explanation of each function. 

1) GetPluginInfo(PLUGIN_INFO * pInfo) 

This function gets plugin information. 

Parameter 
*pInfo : This represents information about the plugin. When the 

function is called, the plugin must assign values to this structure. 

Return 
Success : 0 (PLULGIN_S_SUCCESS) 

Fail : Other 

2) StartPlugin(HANDLE hDone, PLUGIN_DATA* pData) 

This function starts the plugin's operation and stores the output data. 

Parameter 

hDone : An event handler used by the image capture plugin to notify 

SMART IDesigner when the operation is complete. 

If `bUseEvent` in `PLUGIN_INFO` is set to `FALSE`, the `hDone` handle 

will be `NULL`, and indicating that no event will be signaled upon 

successful image capture. 

In this scenario, all capture operations must be completed within this 

`StartPlugin()’ itself. 

Conversely, if `bUseEvent` in `PLUGIN_INFO` is set to `TRUE`, an event 

must be signaled using the ‘hDone’ when the plugin operation is 

completed. 

To signal this event, the function as follows: 

 ::SetEvent(hDone); 

Even if plugin is working, it must finish its operation upon receiving 

an `EndPlugin()’. 

*pData : A pointer of the data sent from SMART IDesigner to the 

plugin. 

Return 
Success : 0 (PLULGIN_S_SUCCESS) 

Fail : Other 

3) EndPlugin() 

This function ends plugin action. 

Parameter 
Make the plugin finishes properly, including thread termination and 

memory deallocation. 
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Return 
Success : 0 (PLULGIN_S_SUCCESS) 

Fail : Other 

4) GetPluginCardData(CStringArray* cardList) 

This function receives the list of card types defined by the plugin. 

Parameter 

cardList : SMART IDesigner receives a list of the card type from the 

plugin. 

This card list is added to the card type combo box in the user-

defined encoding field settings. 

Return 
Success : 0 (PLULGIN_S_SUCCESS) 

Fail : Other 

 

9.2.2 Structure 

1) PLUGIN_INFO 

This structure shows the information of plugin 

 

 szName : The name of the plugin. Make sure it does not conflict with the names of 

other plugins. 

 szDesc : A brief description of the plugin as a string. 

 bUseEvent : Set whether to use the task completion notification event in the plugin. 

If this value is set to `TRUE`, the `StartPlugin()’ receives an event handler and it 

generates event when the operation is complete. If set to `FALSE`, all tasks must be 

completed within the `StartPlugin()’ manually. 

 nTimeOut : If no response is received within the predefined time after `PluginStart`, 

the plugin is finished by calling `EndPlugin()’. Set this value to 0 when `bUseEvent` is 

set to `FALSE`; otherwise, set this timeout value in seconds. 

typedef struct PLUGIN_INFO 

{ 

CString  szName; // Plugin Name 

 CString  szDesc;  // Plugin Description 

 BOOL  bUseEvent; // Event usage 

 int  nTimeOut; // Timeout duration 

 int  nClassId; // Type Of Plugin Class 

}PLUGIN_INFO; 
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 nClassId : Indicates the class code to which this user-defined plugin belongs. 

 

- CLASS_USER_IMAGEACQUISITION indicates the plugin to get images from 

devices such as cameras and signature pads. 

- CLASS_CONTACT_CARD indicates the plugin to encode data on the contact 

smart cards. This class communicates via the PC/SC protocol. 

- CLASS_CONTACTLESS_CARD indicates the plugin to encode data on the 

contactless smart cards. This class communicates via the PC/SC protocol. 

2) PLUGIN_DATA 

`PLUGIN_DATA` is a data structure to share between the plugin and SMART IDesigner. 

The input and output data of this structure varies depending on the class of the plugin. 

 

 nPID : The Printer’s ID to use for printing and encoding 

 nFieldCount : The number of input fields. 

 nCardType : The card type. 

 pFieldList[MAX_FIELDS] : An array of structures containing information about input 

and output fields. The array consists of input fields followed by output fields. 

 pReaderName : The name of the encoder(reader) 

 pImgPath : The path indicates captured image files by the image capture plugin. 

 pOutputList : The `CString` array stores the output values in the order of the output 

fields. 

#define CLASS_USER_IMAGEACQUISITION 0x00000001 

#define CLASS_CONTACT_CARD  0x00000010 

#define CLASS_CONTACTLESS_CARD  0x00000100 

typedef struct PLUGIN_DATA 

{ 

 int   nPID;   // Printer ID 

 int   nFieldCount;  // Number Of Input Field 

 int   nCardType;  // Card Type 

 PLUGIN_FIELD  pFieldList[MAX_FIELDS]; // Field Info List 

 CString   pReaderName;   // Reader Name 

 CString   pImgPath;   // Image Path 

 CStringArray  pOutputList;   // Output Value List 

 PFN   pTransmit;   // PC/SC Function 

 ENCODINGLOG pEncLog;   // Log Function 

}PLUGIN_DATA; 
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 pTransmit : A function for sending PC/SC commands. 

 pEncLog : A function to record log in the “C:\smartlog\smartenc_xxxx_x_xx.log". 

3) PLUGIN_FIELD 

A structure for field information. 

 

 szName : The name of the field. 

 szValue : The value of the field. 

 nType : The type of the field. By default, all fields are defined as text data 

(DATATYPE_STRING). 

 

 nSize : Not used now. 

  

typedef struct PLUGIN_FIELD 

{ 

 CString  szName; // Field Name 

 CString  szValue;  // Field Value 

 int  nType;  // Field Type 

 int  nSize;  // Not Used 

}PLUGIN_FIELD; 

#define   DATATYPE_STRING  1   // Text Type  

#define   DATATYPE_INT  2   // Integer Type 

#define   DATATYPE_RAW  3   // Raw Data Type 
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9.2.3 Plugin Class Description 

There are 3 plugin classes which CLASS_USER_IMAGEACQUISITION, 

CLASS_CONTACT_CARD and CLASS_CONTACTLESS_CARD now. More classess will be 

added in the future. The PLUGIN_DATA depends on Class type. 

Please refer to the below. 

1) CLASS_USER_IMAGEACQUISITION 

If nClassId is CLASS_USER_IMAGEACQUISITION, PLUGIN_INFO and PLUGIN_DATA are 

defined as below. 

 PLUGIN_INFO If the nClassId is `CLASS_USER_IMAGEACQUISITION`, it must send 

plugin information to SMART IDesigner as below; 

PLUGIN_INFO Value 
The target for 

inputting data. 

szName Plugin Name User 

szDesc Plugin Description User 

bUseEvent Event usage (TRUE/FALSE) User 

nTimeOut Timeout duration (seconds) User 

nClassId CLASS_USER_IMAGEACQUISITION User 

Then, Smart IDesigner operates based on received plugin information. 

 PLUGIN_DATA : If nClassID is `CLASS_USER_IMAGEACQUISITION`, it sends the 

captured image path to SMART IDesigner. Therefore, the user must input the image 

capture path data in PLUGIN_DATA. 

PLUGIN_DATA Value 
The target for 

inputting data. 

nPID No data - 

nFieldCount No data - 

nCardType No data - 

pFieldList[MAX_FIELDS] No data - 

pReaderName No data - 

pImgPath Capture image path User 

pOutputList No data - 

pTransmit No data - 

pEncLog No data - 

Smart IDesigner copies the captured image from the received path to the 

"CaptureFiles" folder within the project folder and import it into the image field of 

the card. 
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2) CLASS_CONTACT_CARD / CLASS_CONTACTLESS_CARD 

If nClassId is CLASS_CONTACT_CARD or CLASS_CONTACTLESS_CARD, PLUGIN_INFO and 

PLUGIN_DATA are defined as below. 

 PLUGIN_INFO : If nClassID is CLASS_CONTACT_CARD or CLASS_CONTACTLESS 

_CARD, it must send plugin information to SMART IDesigner as below; 

PLUGIN_INFO Value 
The target for 

inputting data. 

szName Plugin Name User 

szDesc Plugin Description User 

bUseEvent FALSE User 

nTimeOut No data User 

nClassId 
CLASS_CONTACT_CARD or 

CLASS_CONTACTLESS_CARD 
User 

Then, Smart IDesigner operates based on received plugin information. 

 PLUGIN_DATA : If nClassID is CLASS_CONTACT_CARD and CLASS_CONTACTLESS 

_CARD, SMART IDesigner sends the following information to plugin: printer ID, card 

type, field information, number of input fields, reader name, PC/SC communication 

function, and log function which the user selects in the encoding field settings. Then, 

the plugin uses this data to do encoding job and returns the output values. 

PLUGIN_DATA Value 
The target for 

inputting data. 

nPID Printer ID Smart IDesigner 

nFieldCount Number Of Input Field Smart IDesigner 

nCardType Card Type Smart IDesigner 

pFieldList[MAX_FIELDS] Field Info List Smart IDesigner 

pReaderName Reader Name Smart IDesigner 

pImgPath No data - 

pOutputList Output Value List User 

pTransmit PC/SC Function Smart IDesigner 

pEncLog Log Function Smart IDesigner 

 

The `pTransmit` and `pEncLog` function pointers can be used as follows: 
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The `pTransmit` function is used in the same way as the `SmartComm_ICTransmit` or 

`SmartComm_RFTransmit` functions. For more detailed information, refer to the 

SMART SDK manual. 

 

The nFieldCount indicates the number of input fields. If the index of pFieldList array 

is from 0 to nFieldCount – 1, it indicates the input field information; In the other 

hands, if the index is above nFieldCount onwards, it indicates output field 

information. 

  

// PFN Declaration 

typedef int (*PFN)(int, int, DWORD, BYTE*, DWORD*, BYTE*); 

// PFN Usage 

PFN TransmitAPDU; 

TransmitAPDU = *(PFN*)(theApp.pData->pTransmit);  

TransmitAPDU(DEV_INTERNALRF, nlencmd, btCmd, dwlenrcv, btRcv); 

 

// ENCODINGLOG Declaration 

typedef int (*ENCODINGLOG)(WCHAR*, WCHAR*, ...); 

// ENCODINGLOG Usage 

ENCODINGLOG EncLog; 

EncLog = *(ENCODINGLOG*)(theApp.pData->pEncLog);  

EncLog(_T(__FUNCTION__), L”Log Message - %s”, strMsg); 
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9.3 Plugin Example 

9.3.1 CLASS_USER_IMAGEACQUISITION Sample 

You can find the sample project at the following path: 

 Sample Project Path 

C:\Program Files (x86)\Smart IDesigner\Plugin\Plugin_Capture_Sample.zip 

or C:\Program Files\Smart IDesigner\Plugin\Plugin_Capture_Sample.zip 

 

9.3.2 CLASS_CONTACT_CARD, CLASS_CONTACTLESS_CARD 

You can find the sample project at the following path: 

 Sample Project Path 

C:\Program Files (x86)\Smart IDesigner\Plugin\Plugin_Encoding_Sample.zip 

or C:\Program Files\Smart IDesigner\Plugin\Plugin_Encoding_Sample.zip 

 


